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Understanding Symbols

The symbols used in this manual are explained below.

CAUTION

Indicates risk of damage to the PFX20W-12 tester or connected equipment. Always follow the
correct operating procedures.

Before proceeding past a CAUTION sign, make sure all indicated conditions are understood and
met.

NOTE

Indicates additional information, such as operating procedures.

Request for Owner’s Registration
You must complete and send in the enclosed owner’s registration card to receive news of software
upgrades and technical support. Please read the Software License Agreement enclosed, complete the
user registration card, and directly fax or mail it to us. If you do not return the user registration card, you
can’t receive the above service.
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Chapter 1 Introduction

1.1 Product Outline
The SD03-PFX(E) Battery Performance Checker 12 application software, hereafter
referred to as the BPChecker, is a battery characteristics testing system that performs
charge-discharge characteristics tests of batteries by controlling PFX20W-12 testers
(hereafter referred to as frames) via a PC and analyzing test results.

With the BPChecker, up to six frames may be connected. A single PC (Personal
computer) can control up to 72 channels.

Charge-discharge tests are performed by creating patterns (data clusters involving
detailed settings for voltage, current, time, and other charge-discharge
characteristics) with the Test Condition Editor, then running Test Executive. Up to
15 such patterns may be set for a single test, and up to 2000 repetitions may be run,
giving the BPChecker the capacity to handle initial characteristics and battery life
tests.

Using the BPChecker with a TABAI ESPEC protocol converter and temperature
chamber allows tests to be carried out in sync with the temperature chamber.

Pattern-based charge-discharge data and life capacity data for the entire cycle are
saved as files during testing. These test data files are then converted into graphs by
CD Data Graph or Life Data Graph to provide waveform numeric data display, test
result display, and information in other useful formats. The BPChecker comes with a
function that allows test data in text format to be copied and pasted to the clipboard
for manipulation in spreadsheet applications.

The frame has six charge-discharge power supply units of 20 W/2 channels, for a
total of 12 channels. Two channels (A and B) in a power supply unit may be
connected in parallel. By changing the configuration of these channels, the tester can
be used as a charge-discharge power supply unit of 50 W/channel.

The BPChecker is made up of the following four programs, with the following
functions.
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1. Test Condition Editor

The Test Condition Editor is a software that is used to create and edit all test
conditions related to charge-discharge tests carried out by the frames. Test conditions
can be entered per power supply unit, with data required for testing such as test titles
and charge-discharge patterns (data clusters involving detailed settings for voltage,
current, time, and other charge-discharge characteristics) set by the user. The Test
Executive may be run directly from the Test Condition Editor, allowing tests to be
performed instantly under the test conditions currently being edited.

2. Test Executive

The Test Executive sends and receives data for the test conditions prepared with the
Test Condition Editor to and from frames via the GPIB interface for performing
charge-discharge tests.

During the test, the Test Executive monitors voltage, current, capacity, time, and
other parameters for each frame, displaying detailed test conditions and real-time
data graphs. It also saves pattern-based charge-discharge data and life capacity data
for the entire cycle as data files.

3. CD Data Graph

The CD Data Graph handles data files for charge-discharge, converting data for
predischarge, charge, and discharge characteristics into graphs and displaying
waveform numeric data, test results, and other information. It offers several helpful
functions, including search function for file-reads. It also has a function that allows
test data in text format to be copied and pasted to the clipboard for manipulation in
spreadsheet applications.

4. Life Data Graph

The Life Data Graph handles files for life data, converting charge-discharge capacity
data into graphs, switching graph display (the capacity (Y) axis may be switched
between 1.0, 100%, and measured capacity values, and the cycle (X) axis may be
switched between linear and logarithmic displays) and displaying waveform numeric
data, test results, and other information. It offers a search function for file-reads. It
also has a function that allows test data in text format to be copied and pasted to the
clipboard for manipulation in spreadsheet applications.
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1.2 System Requirements
The following are the minimum requirements for running the BPChecker application
software.

■ PC(Personal computer)

PC with a processor of Pentium 100 MHz or better, using WindowsNT Workstation
4.0, Windows95 or Windows98.

OS: WindowsNT Workstation 4.0, Windows95 or Windows98.

For tests that it takes 49 days or more from turning on a
personal computer to completion of test, you should use
WindowsNT Workstation4.0.

Memory: 32 MB or greater

Hard disk: 540 MB or greater (the application itself occupies 3 MB of
disk space). The required hard disk capacity differs from test
method to test method.

Floppy disk drive: 3.5" FD (1.44 MB)

Mouse: Required

Display monitor: We recommend a 17-inch monitor with a resolution of 1024 x
768 or better. The display must be capable of a minimum
resolution of 800 x 600.

Printer: OS-compatible printer

NOTE

• If there is advanced power management (APM) function in the
system setting of your personal computer, turn off the function.
When you perform a test at turning on APM, your personal
computer may not work normally because the interrupt called
SMI for CPU occurs periodically.  To enable APM, click "Start"
button on taskbar, select "Help", and select "Index."  Type
"APM", "advanced power management",  or "power
management" on the text box, and search for the word.  Set
APM according to the help.
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■ Communications requirements

GPIB board: GPIB board with National  Instruments NI-488.2
specifications

GPIB driver: National Instruments NI-488.2M Software for Windows95
Ver. 1.1 or later, or NI-488.2M Software for WindowsNT

The use of a GPIB board requires installation of the GPIB driver. For instructions on
installing the GPIB driver, see the documentation for the driver. For NI-488.2
settings configured in the device manager, always set the Interface Name to “GPIB0”
and GPIB Address Primary to “0.”

GPIB cables IEEE-STD488-compliant cables must be provided according to the
number of the PFX20W-12 testers used.

NOTE

• Turn off the Automatic Serial PolIing function in the setup
property of your GPIB board when you use the SD03-PFX.
Otherwise, the SD03-PFX can not a test normally.

■ Requirements for tests synchronized with a temperature
chamber

Protocol converter TABAI ESPEC PMS-CA or PMS-CG

Temperature chamber Controllable by a TABAI ESPEC protocol converter
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1.3 Software Configuration

Windows application

Printer

Test condition
file (.TXT)

Test condition
file (.TST)

Windows application

PFX20W-12

GPIB

Test condition Editor

Test Exectuive

To be executed 
under the current 
editing conditions

Temperature chamber
test conditions file

(.CBC)

CD Data Graph Life Data Graph

(.DCD) (.TXT) (.LIF) (.TXT)

Charge-discharge
data file
(.TXT)

Life data file
(.TXT)Printer

Protocol converter Temperature
chamber

Charge-discharge data file Life data file

Fig. 1 Software Configuration

Flow of test procedure:

1. – Prepare the test conditions: Test Condition Editor

Prepare the test conditions. That is, determine the test type to be performed.

2. – Carry out the test: Test Executive

Connect DUT to frames and assign the prepared test conditions to the frames.
That is, determine which channel of which unit of which frame will perform
this test. Then, specify the frames, units, and channels to perform the test.

3. – Analyze and evaluate the test data acquired: CD Data Graph/Life Data Graph

Convert the obtained test results into graphs and tables for analysis and
evaluation.
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Chapter 2 Setup

2.1 Package Contents
This BPChecker package contains the following items:

■ Program diskettes 2 (1.44 MB formatted)

■ User’s Manual 1

2.2 Install
Before using the BPChecker, you must install the Battery Performance Checker
application programs to the hard disk. The installation process is handled by the
setup program provided on the setup disk.

1. – Insert the No. 1 setup disk into the floppy disk drive.

2. – Click the [Start] button, point to [Settings], and click on [Control Panel].

3. – Double-click the [Add/Remove Programs] icon.

4. – Click on [Setup] in the [Install/Uninstall] tab.

5. – Follow the setup prompts displayed on the screen.

2.3 Uninstall
1. – Click the [Start] button, point to [Settings], and click on [Control Panel].

2. – Double-click the [Add/Remove Programs] icon.

3. – Select the application you want to uninstall from the list provided in the
[Install/Uninstall] tab, and click on [Add/Remove].

4. – Follow the deletion prompts displayed on the screen.

CAUTION

• Before uninstalling the BPChecker programs, save the required
test conditions and test data into another directory, on this disk
or another disk.
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2.4 Setting the GPIB Addresses
Up to six frames may be connected to a single PC. When connecting frames, you
must set the GPIB address for each frame. The addresses must be set using the DIP
switches on the rear of each frame. Each address is set according to the number of a
frame to be connected; set the addresses as follows. Set the SRQ function to ON in
the same way.

The frames are factory-set to frame 1: address 1.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Setting the DIP switches

Frame 1: address 1

SRQ•• 4816

0

1

12

Frame 2: address 2

SRQ•• 4816

0

1

12

Frame 3: address 3

SRQ•• 4816

0

1

12

Frame 4: address 4

SRQ•• 4816

0

1

12

Frame 5: address 5

SRQ•• 4816

0

1

12

Frame 6: address 6

SRQ•• 4816

0

1

12
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CAUTION

• Do not touch any switches other than those for address and
SRQ.

• After setting up the GPIB addresses, turn the power switch for
the frames off, then on again.



14 Setup SD03-PFX

2.5 Connecting the GPIB Cables
Turn off the power switches for the frames and the PC.

Connect one of the GPIB cable connectors to the PC GPIB port and secure the
connector using the terminal screws.

Connect the other GPIB cable connector to the 1st frame and secure using the
terminal screws.

Connect the 2nd and later frames in series with a GPIB cable.

2.6 Checking Connections
Turn on the frame power switches. After initialization of the frames is complete
(about 30 seconds), start the BPChecker’s Test Executive to confirm that the
Operation column on the Test Executive main screen shows “idle” with respect to the
connected frames.

2.7 For Safe Use
Before conducting a battery test with this software, carefully read the Operation
Manual for the frame to ensure that the DUT (the batteries) are connected correctly
and that the frames are functioning normally. Improper connection of a DUT or the
frame function may lead to DUT damage or serious accidents, such as explosions.
For safety, always set OVP (overvoltage protection, or overcharge prevention), UVP
(undervoltage protection, or over discharge prevention), and OAH (overcharge
capacity protection), unless there are specific reasons for not doing so.
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This chapter describes the configuration of PFX20W-12’s (frames) and the charge-
discharge test modes to be used.

3.1 Frame Configuration
One frame (one PFX20W-12) consists of six electrically isolated units and the
channels separating the output of each unit into two lines.

Each unit is capable of performing tests individually, since each is electrically
isolated from the others. Note that charge-discharge tests cannot be simultaneously
conducted on the channels (A and B) of the same unit. In this case, tests are restricted
to the same test conditions.

Channel A

Channel B

COM

Unit 6

Channel A

Channel B

COM

Unit 2

Channel A

Channel B

COM

Unit 1

Charge/discharge unit

Frame

Isolation
200 VAC IN

PC GPIB

Fig.2 Frame Configuration

PFX20W-12 Charge-
Discharge TestersChapter 3
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3.2 Channel Configuration
A frame is equipped with six 50 W charge-discharge power supplies (hereafter
referred to as units). Each unit can perform charge-discharge tests for a total of 12
channels by dividing the output into 20 W/2 channels.

Unit 1A Unit 2A Unit 3A Unit 4A Unit 5A Unit 6A 

Unit 1B Unit 2B Unit 3B Unit 4B Unit 5B Unit 6B 

PFX20W-12 frame 

Charge-discharge tests may be carried out at different schedules for separate units.
The following chapters describe how to create the test conditions and perform
testing.

Illustration of operations between units in a frame

Unit 1

Unit 2

•

•

•

Unit 6

•

•

•

•   •

•   •

•   •

Charge

Charge

Charge

Charge

Charge

Charge

Discharge

Discharge

Discharge Discharge

Discharge

Discharge

Fig. 3 Image of Operations between the Units

You can set units to a 50 W/6 channel configuration (referred to as a 6-channel
configuration) or 20 W/12 channel configuration (referred to as a 12-channel
configuration) on a per-frame basis.

When a frame is used in 12-channel configuration, the two channels (A and B) in the
units must perform charge-discharge tests under the same testing conditions.
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Illustration of test in 12-channel configuration 

If one unit channel completes charge or 
discharge before the other, that channel will wait 
for the other to complete charging or discharging 
before proceeding to the next status.

Channel A

Channel B

Charge ChargeDischarge

Fig. 4 Illustration of Operations between the Channels

In other respects, the 12-channel configuration differs from the 6-channel
configuration in test operations.

If one channel for a unit has already begun testing, the other channel which has not
started testing may not be started at a subsequent time.

If an alarm is issued to one of the channels, the other channel ceases output. To
resume testing, you must clear the alarm from the channel for which it was issued.
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3.3 Details of Possible Charge-
Discharge Tests

3.3.1 Constant current—constant voltage charge
(CC-CV)

Charge time

CV time

Battery voltage

Charge current

CV voltage

It current
It time

Rest time

Fig. 5 Illustration of Operations in Constant Current - Constant
Voltage Charge

The above figure illustrates the transition from constant current charge to constant
voltage charge, reaching CV time, to resting from charge.

Additional descriptions are given below.

■ Charge time

Indicates the maximum time for a charge period. Charging stops after this time
elapses, if it has not already ended.

■ CV time

CV time refers to the period between the instant at which battery voltage rises to shift
the DUT to constant voltage action and the instant at which charging ends.

■ It current and It time

It current is the current value for detecting charge current, which may be arbitrarily
set by the user when performing a constant voltage charge. After this current is
detected, charging ends after the time set by It time elapses.
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3.3.2 Constant current charge (CC)

Charge time

Battery voltage

Charge current
Rest time 

-dVMaximum voltage

Fig. 6 Illustration of Operations in Constant Current Charge

The above figure illustrates the transition from constant current charge to -dV
detection, end of charge, to resting from charge. Additional descriptions are given
below.

■ Maximum voltage

When the battery voltage reaches this voltage during a charge period, charging ends.
This item is set only in CC charge.

■ -dV voltage

Charging ends when the battery voltage rises to a peak during a charge period, and a
subsequent voltage drop of -dV is detected. This detection may be disabled for the
time set by the -dV mask time, or for a shorter period.
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3.3.3 Constant current discharge (CC)

Discharge time

Battery voltage

Discharge current

Rest time

Cutoff voltage

Discharge current

Fig. 7 Illustration of Operations in Constant Current Discharge

The above figure illustrates the transition from constant current discharge to a drop in
battery voltage to cutoff voltage, end of discharge, to resting from discharge.
Additional descriptions are given below.

■ Discharge time

Indicates the maximum time for a discharge period. If it has not already finished due
to other factors, discharge halts after this time elapses.

■ Discharge current

Constant current value in constant current discharge

■ Cutoff voltage

This is the battery voltage value at which discharging terminates. When battery
voltage drops to this level, discharge ends.
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3.3.4 Constant power discharge (CP)

Discharge time

Battery voltage

Discharge current Rest time

Cutoff voltage

Limit current

Fig. 8 Illustration of Operations in Constant Power Discharge

The above figure illustrates the transition from constant power discharge to a drop in
battery voltage to cutoff voltage, end of discharge, to resting from discharge.
Additional descriptions are given below.

■ Discharge time

Indicates the maximum time of a discharge period. If it has not yet finished due to
other factors, discharge halts after this time elapses.

■ Discharge current

Discharge current changes with battery voltage to maintain the constant power value.

■ Limit current

In constant power discharge, the discharge current increases as the battery voltage
drops. The limit current value is the upper limit for the discharge current.

■ Cutoff voltage

This is the battery voltage value at which discharging terminates. When the battery
voltage lowers to this voltage, discharge ends.
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3.3.5 Pulse discharge (pulse)
Discharge is achieved by the following pulse currents. (The figure below illustrates
the waveform for discharge.)

Voltage 
measuring point

T1 T2

T

d a b c d

T3 T4

I1 I2 I3 I4

Current
waveform

Voltage
waveform

(0.010 to 4.000 A 
for 12-channel 
configuration) 
(0.010 to 5.000 A 
for 6-channel 
configuration) 
T1 to T4: Pulse 
time width (500 µ 
to 650 ms) 

Sampling point
High voltage

Low voltage

Fig. 9 Illustration of Operations of Pulse Currents

■ Current setting

As shown above, up to four current values (I1 to I4) may be set within one cycle.

NOTE

• Current values may be set starting at 0.01 A only for pulse
discharge.

■ Time setting

As shown in the figure above, you may set an On time (T1 to T4) for each current
value.

■ Voltage measurement function

In pulse discharge, the voltage measurement function measures battery voltage at
points “a” to “d” (voltage measurement points) in a single cycle (T) in the figure
above, then acquires the High voltage (upper peak) and Low voltage (lower peak)
from among the values.

Note that more than one cycle may be required to acquire High and Low voltages,
depending on the setting of the pulse time width.
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Discharge time

Battery voltage

Pulse discharge
current

Rest time

Cutoff voltage

Enlarged

Battery
voltage

Pulse
discharge
current

Low voltage 

High voltage

Fig. 10 Illustration of Operations in Pulse Discharge

The above figure illustrates the transition from pulse discharge to a drop in battery
voltage to cutoff voltage, end of pulse discharge, to resting from discharge.
Additional descriptions are given below.

■ Cutoff voltage (for pulse discharge)

This is a battery voltage value at which discharge terminates. For pulse discharge,
discharge ends if the Low voltage in the above figure drops to the cutoff voltage.
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Test Condition Editor
This chapter explores the Test Condition Editor and explains how to create test
conditions.

4.1 What is the Test Condition Editor?
The Test Condition Editor is an application which creates and edits all test conditions
involving charge-discharge testing.

Using the Test Condition Editor, you may set discharge (predischarge) for removing
the electrical charge from a battery before beginning a test, and 15 charge and
discharge patterns.

You may also make settings for a sequence of 15 charge and discharge patterns for
testing, for battery information, and for protection information to prevent overcharge
and over discharge.

After you specify a file name for test conditions, a binary file is created with the
extension “.tst”. The Test Condition Editor also allows you to save files in text
format (extension: .txt) or to copy data to the clipboard.

Creating and Controlling
Test ConditionsChapter 4
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4.2 Creating a Test Conditions File
You may create a test conditions file from scratch, or by modifying an existing file. If
you have just started the Test Condition Editor, no file will be open.

To create new test conditions, select [New] from the [File] menu to open a new file.

To open an existing test conditions file, select [Open] from the [File] menu and select
that file.

Fig. 11 Screen Displayed When You Open a New File

4.3 Creating the Test Conditions
To create the test conditions, select the object file window and select [Properties] in
the [Test Condition] menu. The Test Conditions properties sheet is opened.

The Test Conditions properties sheet consists of the following four pages.

1. A “Comment” property page, into which you enter date, operator, battery type,
and other information

2. A “Sequence” property page, into which you set battery information, battery
protection information, and a test sequence of charge and discharge patterns

3. A “Predischarge” property page, into which you set the conditions of discharge
for removing an electrical charge from a battery before starting charge and
discharge testing

4. “Pattern” property pages, into which you set the conditions for charge and
discharge testing. Property pages for “Pattern 1” to “Pattern 15” are available.

Each property page is described below.
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4.3.1 [Comment] property
Enter date, operator, battery type, and other information into this property page.

Fig. 12 Comment Property

The valid input range for each item is given below:

[Date] box

Input range Max 30 characters in single-byte 

[Operator] box

Input range Max 30 characters in single-byte 

[Battery Type] box

Input range Max 30 characters in single-byte 

[Note] box

Input range Max 30 characters in single-byte 
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4.3.2 [Sequence] property
Enter battery information, battery protection information, and a test sequence of
charge and discharge patterns into this property page.

Fig. 13 Sequence Property

■ Channel Structure

Set frame usage to 6 channels or 12 channels configuration.

The channel configuration setting determines the input ranges for current, voltage,
and power values for the following “Predischarge” and “Pattern 1” to “Pattern 15”.

[12Channels/Frame]

Sets frame operation to 12 channels per frame.

[6Channels/Frame]

Sets frame operation to 6 channels per frame.
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■ Battery Nominal Value

Enter the nominal capacity (mAh) and nominal voltage (V) of the battery to be tested
in this section.

[Capacity (mAh)] box

The nominal capacity value is treated as a reference value for life judgement and
OAH (over charge capacity protection).

[Voltage (V)] box

The nominal voltage value entered is used to determine the axes of a real-time graph
displayed by the “Test Executive.”

■ DUT Protection

Use these functions to prevent damage to a DUT (battery) and to avert serious
accidents, such as battery explosions.

[Voltage/Capacity protection] check box

Check this box to provide voltage/capacity protection. When the check box is
checked, settings for the [OVP (V)], [UVP (V)], and [OAH (%)] boxes are enabled.

[OVP (V)] box

Enter an OVP (V) (overcharge protection) value.

If battery voltage exceeds the OVP (V) value during testing, and the frame aborts the
testing as a warning.

[UVP (V)] box

Enter an UVP (V) (over-discharge protection) value.

If battery voltage falls below the UVP (V) value during testing, and the frame aborts
testing as a warning.

[OAH (%)] box

Enter an OAH (%) (overcharge capacity protection) value.

This value is a ratio to the nominal capacity entered in the battery nominal values.

If battery capacity exceeds the value set by OAH (%) during testing, and the frame
aborts testing as a warning.
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CAUTION

• To prevent damage to a DUT (battery) or serious accidents
such as battery explosions, always set the DUT protection
functions unless there are specific reasons for not doing so.

NOTE

• The maximum handling capacity of the frame is 214.748836
(Ah). The value obtained by multiplying nominal capacity by the
ratio entered in OAH must be less than this capacity.

[Confirm Combine] check box

Check this box to confirm the connection status of the DUT.

The Connection check measures the voltage difference between the current wires and
voltage sensing cable immediately before testing to confirm normal connections,
based on the voltage difference value obtained. An alarm is issued if the result is
abnormal.

NOTE

• Before using the connection check function, make sure you
read and have understood Appendix 5, Connection Check
Function, of the PFX20W-12 12CH Charge-Discharge Tester
Operation Manual.

■ Fixed-Time Operation

[Fixed-Time Operation] check box

Check this box when performing testing for which the test time is fixed to one cycle
(charge time + rest time and discharge time + rest time). Fixed-time operation is
carried out on a unit basis. In fixed-time operation, the test is performed as follows:

• For charge, the terminating factor is CV time, It time, maximum voltage, -∆V, or
charge time. However, in fixed-time operation, even when charge action ends in
response to CV time, It time, maximum voltage, or -∆V, the remaining charge time
is treated as rest time in order to correct the test time.

• For discharge, the terminating factor will be cutoff voltage or discharge time.
However, in fixed-time operation, even when discharge terminates in response to
cutoff voltage, the remaining discharge time is treated as rest time in order to
correct the test time.
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■ Life Judgement

Battery capacity generally degrades as batteries are repeatedly charged and
discharged. In this life judgement section, you will set a percentage relative to
nominal capacity (set to 100%), which is then used to determine whether the battery
is at the end of its life.

[Judgement] check box

Check this box to perform a life judgement. Checking the box enables setting of the
[Capacity Rate (%)] and [Count] boxes. It may be left unchecked if you will not
perform life judgement.

[Capacity Rate (%)] box

Enter a capacity rate (%) for life judgement.

The capacity rate is a rate relative to the nominal capacity entered in the Battery
Nominal Values section.

Input range 0 to 100 (%)

[Count] box

Enter the number of times to determine that the battery is at the end of its service life
if discharge capacity continuously falls below the capacity ratio (%).

■ Recording

Set the method for recording a charge-discharge data file created by “Test
Executive” in this section.

[T/1024] button

The T/1024 records data for predischarge time + rest time, charge time + rest time,
and discharge time + rest time for each test, divided into 1024 data points.

– Data-recording intervals

The data-update interval for a frame is two seconds. Thus, data is recorded only at
two-second intervals. For example, when test conditions are set with a charge time
of 0:05 (for five minutes) and a rest time of 0:01 (for one minute), the recording
interval by calculation is (0:05 + 0:01)/1024 = 0.35 (s), but data can’t be updated at
0.35 (s). In this case, the count of individual data points to be recorded is (0:05 +
0:01)/2 (s) = 180 data items or points. Note that this division time is calculated from
the entered charge time + rest time or discharge time + rest time. The number of
data items to be recorded will thus be fewer if a test is terminated by other factors
(cutoff voltage for discharge, or CV time, It time, maximum voltage, or -∆V for
charge).

[Condition Record] button

Charge-discharge data are recorded by determining whether conditions are satisfied.
When condition recording is selected, the input for delta voltage, delta current, and
delta time is available. Data is recorded by OR for each condition.
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[Delta Voltage (mV)] check box

Sets data recording based on delta voltage.

[Delta Voltage (mV)] box

Data is recorded if battery voltage changes by more than the entered value.

[Delta Current (mA)] check box

Sets data recording based on delta current.

[Delta Current (mA)] box

Data is recorded if the current changes by more than the entered value.

Input range 1 to 999 (mA) 

[Delta Time (s)] check box

Sets data recording by delta time.

[Delta Time (s)] box

Data is recorded if time changes by more than the entered value.

NOTE

• The recording area for the charge-discharge data is a
maximum of 1024 items. When the number of recorded data
items exceeds 1024, data is overwritten to the final point
(1024).
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■ Test Sequence

Set the type of sequence in which “Pattern 1” to “Pattern 15” of charge-discharge
(described later) are executed in this section. The “Test Executive” performs a
charge-discharge test according to the sequence of patterns set here.

The setting is made by entering the number of times to repeat a pattern by “Repeat”
and entering the number of times to repeat all the patterns (15 patterns) by “Loop.”
Charge-discharge tests are performed in sequence, starting at pattern 1.

Pattern n Pattern n + 1

Start End

Repeat Repeat

Loop

Fig. 14 Illustration of Operations in Patterns, Repeats, and Loop

[Repeat] box

Enter the number of times to repeat a pattern. When this value is set to 0, the
particular pattern is skipped.

[Record] check box

Checking this box determines whether or not to save data for voltage, current, and
elapsed time to a file when the relevant pattern is executed (charge, discharge, and
each rest status). When this check box is left unchecked, no data file is saved.

[Loop] box

Enter the number of times to repeat the test of “Pattern 1” to “Pattern 15”, taken as a
whole.

NOTE

• Up to 2000 whole cycles including [Repeat] and [Loop] may be
set.
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4.3.3 [Predischarge/Pattern 1 to Pattern 15] property
This subsection describes the specific settings used to determine the kinds of charge-
discharge testing actually performed.

Predischarge is described along with the discharge item.

■ Charge

Settings for charge conditions and terminating factors in each mode are described
below.

Fig. 15 Pattern 1 to Pattern 15 Properties (Charge)

[Mode] combo box

Enables selection of mode, CC-CV (constant current - constant voltage) or CC
(constant current), in which charge is tested.

The setting items related to the mode selected here are available for input.

[Current (A)] box

Enter a charge current value.
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[Charge Time (h:min)] box

Enter the charge time. Charge time is one of the factors that can terminate charging.
Charge always terminates when this time elapses. When the input is 0:00, charge is
skipped.

Input range 0:00 to 999:59 (h:min) 

[Rest Time (h:min)] box

Enter the rest time (rest status before shifting to discharge) to follow charging. When
the input is 0:00, rest time is skipped.

Input range 0:00 to 999:59 (h:min) 

[CV Voltage (V)] box

Enter a CV voltage value. Set a voltage value at which the battery voltage moves to
constant voltage (CV) action. This box is settable when the mode is CC-CV.

[CV Time (h:min)] box

Enter CV time. CV time is one of the factors that can determine charging termination.
Charging ends when this CV time elapses after constant voltage (CV) action has
started. Setting of this box is enabled in CC-CV mode.

Input range 0:00 to 999:59 (h:min) 

[It Current (A)] box

Enter an It current value.

Enter a current value to be detected during constant voltage (CV) action. Setting of
this box is enabled in CC-CV mode.

[It Time (h:min)] box

Enter the It time. It time is one of the factors that can terminate charging. When this
amount of time has elapsed after the It current has been detected, charging ends.
Setting of this box is enabled in CC-CV mode.

Input range 0:00 to 999:59 (h:min) 
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[Max Voltage (V)] box

Enter the maximum voltage value. Maximum voltage is one of the factors that can
terminate charging. Charging ends when the battery voltage reaches the maximum
voltage. Setting of this box is enabled in CC mode.

[-dV (V)] box

Enter a -dV value. -dV is one of the factors that can terminate charging. Charging
terminates if the battery voltage drops by -dV. Setting of this box is enabled in CC
mode.

Input range 0.001 to 1.000 (V) 

[-dV Mask Time (min)] box

Enter the -dV mask time. Detection of -dV voltage drop will be disabled for the time
set here. Setting of this box is enabled in CC mode.

NOTE

• If a test is conducted with the total for charge time and rest time
set to 0:00, the sequence of patterns, repeats, and loop may
not function properly due to problems related to data
processing time. Thus, the total of the charge time and rest time
must be set to at least 0:01 (for 1 minute). For example, if you
set the charge time to 0:00, rest time must be set to 0:01.
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■ Discharge

Settings for discharge conditions and terminating factors in each mode are described
below.

Fig. 16 Pattern 1 to Pattern 15 Properties (Discharge)

Set test conditions related to discharge in this section.

[Mode] combo box

Enables selection of mode—CC (constant current), CP (constant power), pulse 2
(two values), and pulse 4 (four values)—in which discharge is tested. Setting items
related to the mode selected here are then available for input.

[Discharge Time (h:min)] box

Enter the discharge time. Discharge time is one of the factors that can terminate
discharging. When this discharge time elapses, discharge will terminate even when
battery voltage has not yet reached a cutoff voltage. When input is 0:00, discharge is
skipped.

Input range 0:00 to 999:59 (h:min) 
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[Rest Time (h:min)] box

Enter a rest time (rest status after end of discharge) to follow the end of discharge.
When the input is 0:00, rest is skipped.

Input range 0:00 to 999:59 (h:min) 

[Current (A)] box

Enter a discharge current value. Setting of this box is enabled only in CC mode.

[Wattage(W)] box

Enter a discharge wattage value. Setting of this box is enabled only in CP mode.

[Limit Current (A)] box

Enter a limit current value. Setting of this box is enabled only in CP mode.

[Pulse Current 1 to 4 (A)] boxes

Enter pule current 1 to 4 values. Pulse Current 1 and 2 can be set when in Pulse 2
mode, while Pulse Currents 1, 2, 3, and 4 may be set in Pulse 4 mode.

[Pulse Time 1 to 4 (ms)] boxes

Enter pulse time 1 to 4 values. Pulse Time 1 and 2 can be set when in Pulse 2 mode,
while Pulse Time 1, 2, 3, and 4 may be set in Pulse 4 mode.

[Capacity Voltage (V)] box

Enter a capacity calculation voltage. Capacity calculation voltage is described later.
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[Cutoff Voltage (V)] box

Enter a cutoff voltage. The cutoff voltage is one of the factors that can terminate
discharging. Discharging terminates when the battery voltage reaches the cutoff
voltage, even when discharge time remains.

NOTE

• If a test is conducted with the total for discharge time and rest
time set to 0:00, the sequence of patterns, repeats, and loop
may not function properly due to problems related to data
processing time. The total for discharge time and rest time must
be set no lower than 0:01 (for 1 minute). For example, if you set
the discharge time to 0:00, rest time must be set to 0:01.

■ Capacity Voltage

This function stops totaling discharge capacity when battery voltage, which declines
as discharge progresses, falls below the capacity voltage setting.

Discharge time

Battery voltage

Discharge capacity

Rest time

Capacity
voltage Cutoff

voltage

Fig. 17 Calculation of Total Discharge Capacity, terminating at the
Capacity Voltage

This capacity voltage must be set in any discharge mode.

In constant-current pulse discharge mode, the capacity voltage is determined based
on the Low voltage.
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■ For all Pattern 1 to Pattern 15 properties

[Copy] button

Copies and saves pattern data (charge-discharge data) to the clipboard.

[Paste] button

Pastes clipboard contents to the current pattern data.

[Default] button

Clears pattern data. Selecting this button sets rest time (h:min) for charge to 0:01, rest
time (h:min) for discharge to 0:01, and all other items to 0.

4.4 Storing a File
After creating the test conditions, click the [OK] button to close the Test Conditions
Property screen. If any conflicts are found in the data range or other test conditions
information, an alarm message is displayed. To correct conflicts, follow the prompts
given on the screen.

To save the test conditions, select [Save] or [Save As] from the [File] menu. The file
name extension will be “.tst”.

A test data file created by the “Test Executive” uses the file name specified here.
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4.5 Test Condition Editor Menus

Function

File New Creates new test conditions.

Open... Opens an existing Test Condition Editor file.  Files that may be opened
have a (*.tst) extension.

Close Closes the test conditions file being edited.

Save Saves the edited test conditions data, overwriting the original file (if it
exists).

Save As... Lets you specify a name for saving a new test conditions data file, or saves
test conditions data under a new name.  Save an existing file under a new
name to leave the original file unchanged.  Selecting [Save As] does not
close the file; you may continue editing the file just saved.

Save As Text Let you specify a file name for saving test conditions data in text format.
The extension for a text format file is (*.txt).

Print... Prints test conditions data.

Print Preview Provides an on-screen preview of the data (test conditions) printout.

- About print preview:
Some printer drivers may not return correct character widths for certain font
types, such as TrueType, resulting in longer lines in the print preview
screen (possibly falling off the right margin of the page) than would
actually be printed.  However, data will print properly in actual printing.

Print Setup... Allows selection of a printer and a printing method.  The particular items
that need to be set depend on the particular printer.

Exit Closes the current test conditions file and exits the Test Condition Editor.
Before exiting, it allows you to save the test conditions data just edited.

Edit Copy Text Copies and saves test conditions data to the clipboard in text format.

Cut Cuts and saves test conditions data.

Copy Copies and saves test conditions data.

Paste Pastes data saved by [Cut] or [Copy] to the current test conditions data.

View Toolbar Switches between displaying and hiding the toolbar.

Status bar Switches between displaying and hiding the status bar.

Test Condition Properties Allows you to create test conditions.

Run Test Executive Starts the Test Executive under the current editing conditions, immediately
carrying out a test under these test conditions.

[NOTE]
If the "Test Executive has failed to run" is displayed, the correct startup
path may not have been set.  Start the Test Executive manually and select
[Run] - [Test Executive] again from the Test Condition Editor to enable
automatic registration of the Test Executive path; the Test Executive will
start up normally from the next time.

Window Cascade Overlays windows by incrementally shifting their screen position.  This
arrangement shows each window title bar, allowing quick selection of any
window.

Tile Horizontally Tile windows horizontally.  All windows are displayed, without overlap.

Tile Vertically Tile windows vertically.  All windows are displayed, without overlap.

Arrange Icons Arranges icons at equal intervals, horizontally and vertically.

Close All Closes all windows.

Menu
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Chapter 5 Performing Tests

Test Executive
This chapter describes test screens and procedures involved in running the tests.

5.1 Introduction
The Test Executive application runs charge-discharge tests according to test
conditions files created in the Test Condition Editor.

Fig. 18 Test Executive Main Screen
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The Test Executive consists of three windows.

1. Monitoring window

Called the monitoring window, the upper window displays real-time data for current,
voltage, and other values for six frames (the update time can be set using [Monitor
Data Update Interval] from the [Options] menu).

2. Test conditions window

The window at the lower left is called a test condition window. It displays test
conditions for a selected unit (a unit may be selected from the [View] menu).

3. Real-time window

The window at the lower right is a real-time window that displays graphs of voltage
and current in real-time while the selected unit operates. Real-time graphs are
displayed in separate top and bottom parts, with the top part displaying a graph for
channel A of the unit and the bottom part showing a graph for channel B. No graph is
displayed in the bottom section when the frame is used in 6-channel configuration.
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5.2 Operational Flowchart
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5.3 Starting the Test Executive
The Test Executive is capable of controlling a maximum of six frames, identifying
frames to be controlled at startup.

If power to a frame is off or a GPIB address has been specified incorrectly, the frame
cannot be identified and will fall outside the list of frames to be controlled.

Confirm that a frame is connected by checking the [State] item in the following
dialog box (it should indicate “Connected” at the relevant frame).

This Frame Connection dialog box may be opened by selecting [Frame Connection]
from the [Options] menu.

Fig. 19 Checking the Frame Connection

If a frame that needs to be connected is not indicated as “Connected” in this dialog
box, reconfirm that power for the frame is on, the GPIB address setting is correct, and
that the GPIB cable has been connected properly, then press the [Stop Monitor]
button in the Frame Connection dialog box.

The [Reconnect] button becomes selectable; press the [Reconnect] button. Recheck
the connectable frames.
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5.4 Setting and Running the Test Conditions

5.4.1 Setting the test conditions
Before performing a test, you need to assign to the units a test conditions file
(extension: *.tst) created by the Test Condition Editor.

To assign a test conditions file, select [Open] from the [File] menu.

Select a file name from the dialog box displayed. Select the test conditions file
created by the Test Condition Editor.

Fig. 20 Opening a File

Set the units to which the selected test conditions file is to be assigned. You may not
select a unit currently performing a test.

If you start the Test Executive directly from the Test Condition Editor, the file
selection step is omitted, and the procedure begins from this section.

Fig. 21 Selecting a Frame and the Units for Which the File is Opened
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5.4.2 Running the test
The test can be run after the test conditions are assigned to the unit.

Select [Start] from the [Test] menu. The following dialog box appears to the unit.

Fig. 22 Selecting a Frame and the Units for which the Test is Run

Select the units to run. You may select only those with assigned test conditions.

The units that may be run allow entry of up to 16 characters into [DUT Name] for
comments. Comments entered here are printed by the CD Data Graph application
(described later).

When starting the test beginning at charge, press the [OK] button after selecting the
object units.
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If you wish to start the test from predischarge, open the Predischarge property page to
check the “Do Predischarge” check box, then press the [OK] button.

The test starts in the selected units.

Fig. 23 Check This Item When Starting the Test at Predischarge
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5.4.3 Quitting the test
To quit the test, select [Quit] from the [Test] menu. The following dialog box
appears.

Fig. 24 Selecting a Frame and the Units at which the Test is Quitted

The test quits once a unit has been selected.

5.4.4 Pausing the test
To pause the test, select [Stop] from the [Test] menu. The following dialog box
appears.

Fig. 25 Selecting a Frame and the Units at which the Test is Paused

When you set the unit at which you wish to pause the test, the test pauses when the
current cycle is complete, with this state persisting until the test is resumed or quitted.
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5.4.5 Resuming the test
To restart the test previously paused, select [Restart] from the [Test] menu. The
following dialog box appears.

Fig. 26 Selecting a Frame and the Units at which the Test is
Resumed

In this dialog box, select only those units that have been paused. Once you select the
object units, the test restarts. When the test is restarted after the test have been paused
for a long time, characteristics of batteries may have changed.



52 Performing Tests SD03-PFX

5.5 Functions Related to the Screen
Display

5.5.1 How to view the monitoring window

[F:U]

Indicates frame and unit numbers. With the frame configured to operate in 12-
channels, the units are identified by assigning “A” or “B” to their numbers. To switch
frames, select [Frame] from the [View] menu.

[Operation]

Indicates the operational state for each channel. The items to be indicated and their
meaning are given below: 

Indication Description 

Idle Waiting state 

Sidle Waiting state for synchronisation

PDis-CC Predischarge - constant current 

PDis-CP Predischarge - constant power 

PDis-Pulse Predischarge - pulse 

PDis-Power Limit Predischarge - power limitation 

PDis-Rest Predischarge - rest 

PDis-Sync Predischarge - synchronization 

Char-CC Charge - constant current 

Char-CV Charge - constant voltage 

Char-Rest Charge - rest 

Char-Sync Charge - synchronization 

Disc-CC Discharge - constant current 

Disc-CP Discharge - constant power 

Disc-Pulse Discharge - pulse 

Disc-Power Limit Discharge - power limitation 

Disc-Rest Discharge - rest 

OHP CD board OHP (overheat protection) activated 

PS/B PS board error 

CD/B CD board error 

OVP OVP (overcharge protection) activated 

UVP UVP (overdischarge protection) activated 

OAH OAH (overcharge capacity protection) activated 

Connection Error DUT connection error 

---- Frame/unit has been disconnected, or SRQ switch is off. 

[High (V), Low (V), (A), (mAh), (h:min:s)]

Indicates voltage (V), current (A), capacity (mAh), and charge-discharge times
(h:min:s) for batteries.
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NOTE

• The High (V) column denotes High (V) data emitted only during
pulse discharge, displaying “---” emitted during any charge or
discharge other than pulse discharge.

• The Low (V) column denotes Low voltage emitted during pulse
discharge, or steady-state voltage emitted during any charge or
discharge other than pulse discharge.

• The current value for pulse discharge shows an average
current calculated from the set pulse current value and the
value of the pulse time width. This value is also used to
calculate battery capacity.

• The PFX20W-12’s current measuring capability does not
assure an accuracy of 2 mA or below. Thus, if a measured
current value is less than 2 mA, capacity will not be calculated
to avoid measurement error.

[Cycle (P/R/L)]

Displays the total number for test cycles, pattern, repeat, and loop being executed.

[State]

Displays the pause state or the state in which a test was terminated. This state is
cleared when the test resumes. 

Indication Description

Pause Test is being paused.

-END- Normal termination, according to setting conditions

Quit Termination due to selection of Stop or Emergency Stop

Life Termination due to life judgement

OHP Stop due to tripping of OHP (overheat protection) of CD board

PS/B Stop due to PS board error

CD/B Stop due to CD board error

OVP Stop due to tripping of OVP (overcharge protection)

UVP Stop due to tripping of UVP (over discharge protection)

OAH Stop due to tripping of OAH (overcharge capacity protection)

Connection Error Stop due to DUT connection error

Communication
Error

Stop due to frame power failure or a GPIB error

CPU error Stop due to frame CPU error

AC Line Stop due to sudden AC power line failure

[DUT Name]

Displays the DUT name entered when selecting a unit to run a test.

[File Name]

Displays file name for a test conditions file.
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5.5.2 Changing the update time of the monitoring
window

The data update time for the monitoring window can be set to 3, 6, 15, or 30 seconds
by selecting [Monitor Data Update Interval] from the [Options] menu.

Fig. 27 Changing the Monitoring Data Update Interval

5.5.3 Changing the axes for the real-time data
Select [Graph Scale] from the [View] menu to change the vertical (Y) and horizontal
(X) axes of the graphs displayed.

Fig. 28 Screen for Changing Graph Axes

The Graph Scale properties sheet consists of the “X axis”, “Y axis”, and “Style”
pages.
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■ Setting items in the [X Axis] and [Y Axis] properties

[Step] slider

Adjust the slider knob to change the number of axis scale marks. The number of
divisions that may be set range from 1 to 12.

[Min], [Max] and [Step] boxes

For the X axis page, enter the minimum and maximum values for the time axis of
graphs.

For the Y axis page, enter the minimum and maximum values of graphs of voltage,
current, and capacity.

The present value per division is displyed at the [Step] box.

■ Setting items in the [Style] property

[Grid] check box

Check this check box to superimpose grids upon graphs.

[Step] slider

Set the size of the grid squares by moving the slider knob. The number of divisions
that may be set is 2, 4, and 5.

[Pen Width]

Sets the width of the pen of the data.

[Back Color, Axis Color, Axis Width]

Sets the Back Color, Axis Color and Axis Width of Graph.



56 Performing Tests SD03-PFX

5.6 Reconnecting a Frame
If a frame issues a GPIB communications error due to defects, power supply
problems, or other reasons, the Test Executive automatically shuts off the connection
for the frame where the communications error occurred, in order to continue tests on
other frames.

To reconnect the frame, follow the procedure below.

1. – When multiple frames are connected, pause all channels currently running
tests.

2. – Select [Frame Connection] from the [Options] menu to open the Connect
Frame dialog box.

Fig. 29 Connect Frame Dialog Box

3. – Press the [Stop Monitor] button. Then press the [Reconnect] button and
confirm that “Connected” is indicated at the relevant frame. After checking the
frame connections, press the [Close] button to close the dialog box.

4. – Select [Restart] from the [Test] menu to restart the test.

Precautions for reconnection

• When multiple frames are running tests, set all channels concerned to pause state,
then reconnect. This is done to maintain testing continuity for the channels
through which tests are being run.

• Resolve the error or problem in the frame whose connection has been shut off,
then reconnect.
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5.7 Resuming the Previous Test
If a test is terminated in midcourse under the following conditions, the Test
Executive allows you to resume this test when it is launched.

Conditions of termination under which a test may be resumed:

1. The Test Executive is terminated by setting all channels running tests to pause
state by selecting [Stop] from the [Test] menu

2. If the personal computer power supply is interrupted for some reason, such as
power failure

3. If the power supply for a frame running a test is shut down, resulting in a GPIB
communications error

NOTE

• If the power supply for the frame was shut down, set the
channels for the frames currently running tests without
problems to pause state, then exit the Test Executive.

If channels exist through which the test may be continued, the Test Executive
displays the following dialog box, on being launched. To continue testing, select
[Yes] in this dialog box.

If you select [No], the Test Executive starts by resetting continuity information.

Fig. 30 Dialog box displayed if a channel exists through
which a continuation test may be resumed when
the Test Executive is started
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The dialog box allowing selection of units to resume testing is displayed. Select the
channels through which the test is to be resumed in this dialog box.

To carry out discharge before resuming the test, open the Predischarge property page
and click the check box. This performs a preliminary discharge first, then resumes
the test.

Fig. 31 Selecting the Frame/Units to Resume Testing

Occurrence of 
power failure in the 
middle of cycle 4

Resumption 
starting at 
predischarge

Test resumption

Cycle 3 Cycle 4 Cycle 4

Fig. 32 Illustration of Resumption after a Power Failure

The capacity of the cycle when the test was restarted without a predischarge becomes
a smaller one. Note that the capacity of a cycle depends on conditions at a power
failure. It is reason why the battery is not in a condition after a discharge was paused,
but is in a condition that the battery was charged to a certain extent. When the test
was restarted with a predischarge, characteristic of a battery may be back to
conditions near to initial one. The Test Executive can adjust the number of cycle at
restarting a test after a power failure, but cannot correspond to a change of
characteristic of a battery.
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5.8 Changing Test Conditions during a
Test

A function within the Test Executive allows you to change test conditions for a unit
in the middle of testing.

To modify test conditions during a test, set the unit to pause state by selecting [Stop]
from the [Test] menu.

Start the Test Condition Editor and change the test conditions file assigned to the
unit. In this case, the object items are the contents of the test of “Pattern 1” to “Pattern
15” for charge and discharge.

Altering this sequence renders the Test Executive incapable of updating the test
conditions file.

After changing the test conditions file, select [Apply Condition] from the [File]
menu.

Fig. 33 Selecting the Frame/Units Whose Test Conditions are to be
Updated

In this dialog box, you may check only those units whose test conditions may be
updated. Specify a unit whose test conditions file is to be updated and press the [OK]
button. This completes the update.

Select [Restart] from the [Test] menu to resume testing.
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5.9 Testing in Synchronization with a
Temperature Chamber

The Test Executive allows a test to be carried out in synchronization with a
temperature chamber on a per-frame basis.

Performing testing synchronized with a temperature chamber requires the following.

• Equipment required (manufacturer: TABAI ESPEC CORP.)

1. Protocol converter PMS-CA or PMS-CG

2. Temperature chamber controllable by a protocol converter

• Setting the protocol converter and temperature chamber

1. Protocol converter GPIB address: 10

2. Temperature chamber address: 1

NOTE

• For information on connections between the protocol converter
and temperature chamber, see the operation manual for those
pieces of equipment.

When the operation requirements are met, turn on the protocol converter and
temperature chamber power switches before starting the Test Executive.

Once launched, the Test Executive identifies and initializes the connected
temperature chamber system.

If the Test Executive is unable to identify the chamber, open [Properties] from the
[Chamber] menu. The Temperature Chamber property appears as shown in Fig. 34.

You cannot edit any conditional settings related to the test synchronized with the
temperature chamber.
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Fig. 34 Screen Showing Conditions under which Synchronized
Testing with the Temperature Chamber is Disabled

When the temperature chamber system is connected correctly, the setting items for
each property become valid.

Fig. 35 Screen Showing Conditions under which the Test
Synchronized with the Temperature Chamber is Enabled

The Temperature Chamber properties consist of the “General,” “Individual
Settings,” and “Collective Settings” pages.

The following provides detailed information for each property page.
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5.9.1 [General] property
In the General property page, specify a frame to run a test in synchronization with the
temperature chamber, select the method for setting the temperature for
synchronization with the chamber, and browse and save a temperature chamber test
conditions file.

[Chamber Synchronization] check box

Check a frame that runs a test in synchronization with the temperature chamber. All
channels of the frame checked will conduct the synchronization test.

A frame cannot be specified for the test synchronized with the temperature chamber
under the following conditions:

1. A frame is already running a charge-discharge testing.

2. There is no object frame.

[Setting Method] radio buttons

You can select the method for setting temperatures for the temperature chamber.
Select either individual or collective settings.

The setting method selected here determines which setting conditions for “Individual
Settings” or “Collective Settings” property apply to synchronization with the
temperature chamber.

The individual settings and collective settings are described in the following
subsections.

[Judgement (°C) ±] and [Wait Time (min)] boxes

For “Judgement,” enter a temperature at which the counting of waiting time starts as
the temperature of the temperature chamber approaches a set temperature.

For “Wait Time,” set the time taken by temperature chamber to stabilize after
reaching the judgement temperature. A charge-discharge test starts when the time set
in this box has elapsed.

Set a temperature on “Individual settings” or “Collective settings” property page.

At the setting temperature is 40 °C and the judgement temperature is ±0.5 °C, the
range from 39.6 °C to 40.4 °C is the range for judgment. The temperature of the
temperature chamber changes until it has settled down to the setting temperature. The
temperature of the temperature chamber is watched every 15 seconds. Therefore, the
wait time may be started when the temperature went across the range for judgment at
first, or may not be started until the temperature actually settls down. Set a wait time
considering such a time.

  Input range

 Judgement (℃) ±  0.0 to 10.0

 Wait time (min)  0 to 120
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Wait time
Judgment
temperature (±)

Test start

Setting
temperature

Time

Temperature of
the temperature
chamber

Fig. 36 Illustration of Setting Temperature for the Temperature
Chamber and Start of Testing

When the test synchronized with the temperature chamber starts, the following
message box is displayed until the temperature of the temperature chamber reaches
the “Judgement temperature” and the “Wait time” elapses.

Fig. 37 Message Box Displayed as Temperature of the Temperature
Chamber is Brought to the Set Temperature

[Save] button

The setting condition may be saved as a file. Always save the test conditions before
starting a test.

Fig. 38 Saving Temperature Chamber Test Conditions
 (Extension: .cbc)
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[Browse] button

Click this button to load test conditions which are already saved to a file.

Fig. 39 Browsing a Temperature Chamber Test conditions file

5.9.2 [Individual Settings] property
Individual setting is selected when temperatures of the temperature chamber are
changed at points.

Fig. 40 Individual Settings Property
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[Cycle] box

Enter the number of the cycle at which the temperature chamber is set.

[Mode] button

Select either the Charge or Discharge button for [Cycle].

[Temp (°C)] box

Enter the temperature to be set to the temperature chamber.

[Insert] button

Inserts the set values for [Cycle], [Mode], and [Tempe (°C)] to the list. The settings
for [Cycle], [Mode], and [Tempe (°C)] set the target temperature the temperature
chamber reaches from charge or discharge for the particular cycle. Cycle number 0 is
regarded as the predischarge.

For example, when the following are set,

Cycle Mode Tempe (℃)

0 Discharge 25

1 Charge 40

5 Discharge 0

30 Discharge 20

temperature of the temperature chamber is raised to 25 °C from cycle 0
(predischarge), raised to 40 °C from cycle-1 charge, lowered to 0 °C from cycle-5
discharge, and then raised to 20 °C from cycle-30 discharge.

[Delete] button

Deletes a specified condition from the list.

[Delete All] button

Deletes all conditions in the list.
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5.9.3 [Collective Settings] property
Collective setting is selected when the patterns of temperature chamber temperatures
are fixed to some extent in charge and discharge. You can set the temperatures in
charge and discharge in a single pattern, and a value for number of repetitions for
each pattern.

Fig. 41 Collective Settings Property

[Charge Temp (°C)], [Discharge Temp (°C)], and [Count] boxes

Set temperature of the temperature chamber in charge and discharge and the number
of times to repeat the patterns of charge and discharge.

 Input range 

 Charge temperatures (℃)
 Discharge temperature (℃)

 -50 to 100

Count  1 to 2000 

For example, when the following are set,

Pattern 1 Charge temp.: 25 °C, discharge temp.: -10 °C, number of times: 10

Pattern 2 Charge temp.: 30 °C, discharge temp.: 5 °C, number of times: 10

Pattern 3 Charge temp.: 30 °C, discharge temp.: 10 °C, number of times: 10

temperature of the temperature chamber can be changed to 25 °C in charge and -10
°C in discharge from cycles 1 to 10, to 30 °C in charge and 5 °C in discharge from
cycles 11 to 20, and to 30 °C in charge and 10 °C in discharge from cycles 21 to 30.
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[Insert] button

Inserts the set values in [Charge Temp (°C)], [Discharge Temp (°C)], and [Count] to
the list.

[Delete] button

Deletes a specified condition from the list.

[Delete All] button

Deletes all conditions in the list.

NOTE

• The maximum number of temperature patterns that may be set
in individual settings and collective settings is 100.

• A frame cannot be added to a test synchronized with the
temperature chamber while a test is being performed.

• If an alarm occurs in a channel during a test synchronized with
the temperature chamber, the test of that channel will be halted
at the occurrence of such an alarm. The other channels will
continue the test synchronized with the temperature chamber.

• The conditions for a test synchronized with the temperature
chamber may be checked but not edited or changed during
testing.

• Pay attention to dew condensation in sudden temperature
change.
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5.10 Graph Data to be Created
The Test Executive saves charge-discharge data for each cycle and life data to data
files.

■ Charge-discharge data files

For charge-discharge data files, the test data for one channel of one basic pattern
(charge + rest, and discharge + rest) is saved as a single file.

Data files are stored in the folder containing the test conditions file.

Data files are created for patterns for which the [Recording] check boxes in the
Sequence page of the Test Condition Properties have been checked.

The last cycle of a test will always be saved as a file, regardless of the setting in the
Test Condition Properties.

File names assigned

FUC0001TST.dcd: F = frame number (1 to 6)

FUC0001TST.dcd: U = unit number (1 to 6)

FUC0001TST.dcd: C = channel  number  A or  B for  12-channel
configuration or X for 6-channel configuration

FUC0001TST.dcd: 0001 = number of accumulated cycles (0000 to 2000)

FUC0001TST.dcd: TST = test conditions file name

FUC0001TST.dcd: dcd = extension dcd or txt (extension differs with the
setting of the file format)

The number of accumulated cycles “0000” indicates predischarge data.

■ Life data files

For life data files, the capacity data for the whole charge and discharge of one
channel is saved as a single file.

Life data files are stored in the folder containing test conditions files.

Capacity data for all cycles will be saved to a file, regardless of the setting in the Test
Condition Properties.

File name assigned

FUCTST.lif: F = frame number (1 to 6)

FUCTST.lif: U = unit number (1 to 6)

FUCTST.lif: C = channel number A or B for 12-channel configuration or X
for 6-channel configuration

FUCTST.lif: TST = test conditions file name

FUCTST.lif: lif = extension lif or txt (extension differs with the setting of the
file format)
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Files may be saved in binary or text formats, depending on the setting made in the
Test Executive. Select [Save File Format] from the [Options] menu and make the
desired setting.

Fig. 42 Selecting the Format of Files to be Saved

[Binary (*.dcd, *.lif)] radio button

Selecting this option saves charge-discharge data and life data in binary format
(*.dcd or *.lif), which can be read by CD Data Graph or Life Data Graph.

[Text (separated by tab *.txt)] radio button

Selecting this option saves charge-discharge data and life data in text format, with tab
data delimiters.

NOTE

• The file format may not be set during testing.

• When the system saves test data in text format, measured data
may not be fully captured, depending on the processing time
required to perform the conversion into text format for large
data quantities.

• Do not move with the folder(s) and file(s) related to the test
during a test.  When the folder(s) and file(s) are not found, your
system cannot store data.
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5.11 Test Executive Menus

Function

File Open Loads a test conditions file into specified frame and unit.  Select the page for the
specified frame and click the appropriate unit check boxes.

Apply
Condition...

Updates test conditions for specified frame and unit.  Select the page of the
specified frame and click the appropriate unit check boxes.  Test conditions may
be updated only for those units that have been paused during testing.  For those
not currently running a test, a new test conditions file may be created, or an
existing one overwritten, by selecting [File] - [Open].

Close Closes the test conditions file for specified frame and unit.  Select the page of
the specified frame and click the appropriate unit check boxes.

- Possible reasons file close is disabled:
No test conditions data has been loaded.
A test is running.

Exit Exits the Test Executive.  You can exit the Test Executive only when no tests
are being carried out or when the units have been paused and are in "Idle" or
"Sidle" state (condition where they are in pause state and the current cycle has
been complete).  If any unit is still running a test, you will not be allowed to
exit Test Executive.
For tests that were terminated in pause state, the relevant test information is
written to the database; the test state can be recovered when the Test Executive is
next launched.

View Frame Allows you to select from active frames 1 to 6 displayed.

Unit Allows you to select from active units 1 to 6 displayed.

Standard Toolbar Displays or hides the standard toolbar.

Frame : Unit
Toolbar

Displays or hides the frame & unit toolbar.

Statusbar Displays or hides the state bar.

Graph Scale... Allows you to set the scale value for real-time graphs.

Test Start Starts a test for specified frame and unit.

- Possible factors preventing the start of testing:
No test condition data has been loaded.
A test is running.
Sufficient space (at least 3 MB) is unavailable on the data storage drive.
The relevant frame or unit is not connected.
An alarm has occurred.

Stop Pauses the test for specified frame and unit at the current pattern (after resting
from discharge).  When testing is paused, the "state" column in the monitoring
window displays "Pause" at the relevant frame:unit.

- Possible factors preventing pause:
No test is running.

Restart Resumes testing for specified frame and unit previously paused.

- Possible factors preventing resumption:
No test has been paused.

Quit Stops testing for specified frame and unit, saving charge-discharge data and life
data, before halting testing.  Once the test is stopped, "Quit" appears in the
monitoring window.

- Possible factors preventing stop:
No test is running.

Menu
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Function

Test Reset Alarm... Resets an alarm occurring at specified frame and unit.  A test will be stopped at
the instant an alarm occurs, with each error displayed in the "state" column in
the monitoring window.

- Possible factors disabling use of the check box:
No alarm has occurred.

Emergency Stop Immediately stops all tests, after saving charge-discharge data and life data.  The
monitoring window displays "Quit."

Options Monitor Data
Update Interval

Allows you to set the update time for the monitoring window.

Frame
Connection...

Identifies the frames connected and reconnects a frame.
If a defect or error occurs at a specific frame, select [Test] - [Quit] to stop the test
for the specific frame, then select [Test] - [Stop] to pause all other normal units
currently running the test.  When those units enter "Idle" state, press the [Stop
Monitoring] button to remove the object frame from the GPIB system, then
select [Reconnect] and [Test] - [Restart] to resume testing for other units.  This
allows you to remove the defective frame from the system without aborting the
test; it also allows you to add a frame to the system.  A Test Executive function
permits forcibly shutting off the connection for a frame that has caused a GPIB
communications error.

Save File
Format...

Allows you to select the file format for the saved file.

Chamber Properties... Allows you to set the conditions for a test synchronized with the temperature
chamber.

Menu



72 Performing Tests SD03-PFX

5.12 Detailed Alarm Information and
Appropriate Corrective Action

DUT (battery) protection related alarms

Symbol Name
ALRM
lamp

Description Remedy

OVP Overcharge protection On
DUT (battery) voltage has exceeded an OVP voltage
value during testing.

Release by
reset alarm.

UVP
Over-discharge
protection

On
DUT (battery) voltage has fallen below an UVP
voltage value during testing.

Release by
reset alarm.

OAH
Overcharge capacity
protection

Off
Totalized capacity has exceeded an OAH capacity
value during charge testing.

Release by
reset alarm.

Connection
Error

DUT (battery)
connection error

On

DUT (battery) has not been connected properly.
Possibly this is the result of an incorrect wire
connection with the DUT or poor connections, such
as a broken wire. Confirm connections.

Release by
reset alarm.

System/hardware-related alarms

*1 If CPU communications errors occur frequently, the frame may be defective. Contact Kikusui
distributor/agent.

*2 If the alarm persists even when problems are resolved, the frame may be defective. Contact Kikusui
distributor/agent.
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Chapter 6

CD Data Graph
This chapter describes procedures for graphing charge-discharge data (extension:
*.dcd) created by the Test Executive, for on-screen display or printout.

6.1 Opening a Charge-Discharge Graph
File

Graphs may be displayed either by directly specifying folder and file names or by
retrieving a charge-discharge graph file for certain conditions.

6.1.1 Graphing by specifying a file name
To display graphs by specifying a file name directly, select [Open] from the [File]
menu.

Select a file name from the displayed dialog box. Specify the name of the folder
containing charge-discharge data files created by the Test Executive, and select a
desired file. Graphs for the specified file are displayed.

Fig. 43 Opening a Charge-Discharge Graph File

Graphing the Charge and
Discharge Results
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6.1.2 Graphing by retrieving a file
To display graphs by retrieving charge-discharge data files, select [Find File] from
the [File] menu. The following Find File dialog box appears.

Fig. 44 Finding a File 1/2

Next, click the [Browse...] button at the “Find for” to specify the folder name of the
charge-discharge data files created by the Test Executive.

Fig. 45 Specifying the Folder

Specify the folder and click the [OK] button. This returns you to the previous dialog
box.
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After specifying the folder, set the retrieval conditions. There are two retrieval
conditions: a method for “Find All Files” and for “Specify File To Find.”

When you select “Specify File To Find,” the Find File dialog box allows you to
specify a frame, unit, channel, and cycle. The CD Data Graph executes retrieval by
OR of the condition specified here.

After specifying the retrieval conditions, click the [Next] button. The following
dialog box appears, listing the files meeting the retrieval conditions.

Fig. 46 Finding a File 2/2

Select a charge-discharge data file you wish to graph and click the [Finish] button.

NOTE

• The maximum number of files that may be retrieved is 2000
maximum.
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6.2 Displaying Graphs
Graphs display charge and discharge data individually, but shows voltage and
current data together. When you first display graphs, the CD Data Graph displays
graphs for charge data.

To switch graphs between charge and discharge data, select [Charge Graph]/
[Discharge Graph] from the [View] menu.

The graph types are indicated by color, as shown below:

Voltage ➝ green

Current ➝ red

Fig. 47 Graph Display Screen
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6.3 Setting Graph Axes
Select [Graph Scale] from the [View] menu to change the formats for the vertical (Y)
and horizontal (X) axes of the displayed graphs.

Fig. 48 Screen for Changing the Graph Axes

The Graph Scale properties sheet consists of the “X axis”, “Y axis”, and “Style”
pages.

■ Setting items in the [X axis] and [Y axis] properties

[Step] slider

Use the slider knob to set the number of divisions of the axis scale marks from 1 to
12.

[Min], [Max] and [Step] boxes

For the X axis page, enter the minimum and maximum values for the graph’s time
axis.

For the Y axis page, enter the minimum and maximum values for graphs of voltage
and current.

The present value per division is displyed at the [Step] box.
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■ Setting items in the [Style] property

[Grid] check box

Check this check box to superimpose grids upon graphs.

[Step] slider

Use the slider knob to set the size of the grid squares to 2, 4, or 5.

[Pen Width]

Sets the width of the pen of the data.

[Back Color, Axis Color, Axis Width]

Sets the Back Color, Axis Color and Axis Width of Graph.
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6.4 Displaying the Test Results
You can browse the test conditions and test results data for the displayed graphs.

To display test results, select [Properties] from the [Test Results] menu.

The Test Result properties sheet consists of the following three pages.

1. “General Info” property page, displaying nominal values for the battery being
tested, data recording conditions, and other information

2. “Charge” property page displaying test conditions and test results for charge

3. “Discharge” property page displaying test conditions and test results for
discharge

6.4.1 [General Info] property
This property lists the object information for the test data file.

Fig. 49 Test Results of General Info

[Memo] box

Allows entry of up to single-byte 30 characters of comments. A character string
entered here is displayed in the memo item in printing.
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6.4.2 [Charge] property
This property displays the test conditions and test results for charge.

Fig. 50 Test Results of Charge
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■ Test Results

This section displays the results for charge testing.

Test result item Description

Finished By Max. time: Charge ends at charge time.
Max. voltage: Charge ends at the maximum voltage.
CV time: Charge ends at CV time.
It time: Charge ends at It time.
-dV: Charge ends due to a voltage drop of -dV.
OAH: Stop due to tripping of OAH (overcharge capacity protection)
Connection Error: Stop due to DUT connection error
PS/B: Stop due to PS board error
OHP: Stop due to tripping of OHP of CD board
CD/B: Stop due to CD board error
UVP: Stop due to tripping of UVP
OVP: Stop due to tripping of OVP
Stop: Stop due to selection of Stop or Emergency Stop
Communication Error: Stop due to a GPIB error or power failure
CPU error: Stop due to CPU error
AC Line: Stop due to sudden AC power line failure
---: Test not carried out
?: Other causes

Charge Capacity Capacity value

Charge Time Charge time

CC time Elapsed time during shift from constant current (CC) to constant
voltage (CV)

Unloaded voltage Terminal voltage at no-load conditions about 2 seconds before start

Starting voltage Terminal voltage about 500 ms after start

Max Voltage Maximum voltage attained during test

Finished Voltage Terminal voltage at the end of testing
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6.4.3 [Discharge] property
This property displays test conditions and test results for discharge.

Fig. 51 Test Results of Discharge
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■ Test Results

This section displays the results of discharge testing.

Test result item Description

Finished By Cutoff voltage: Discharge ends at the cutoff voltage of test
conditions.
Discharge time: Discharge ends at discharge time of test
conditions.
Connection Error: Stop due to DUT connection error
PS/B: Stop due to PS board error
OHP: Stop due to tripping of OHP of CD board
CD/B: Stop due to CD board error
UVP: Stop due to tripping of UVP
OVP: Stop due to tripping of OVP
Stop: Stop due to selection of Stop or Emergency Stop
Communication Error: Stop due to GPIB error or power failure
CPU error: Stop due to CPU error
AC Line: Stop due to sudden AC power line failure
---: Test not carried out

Discharge Capacity Capacity value

Discharge Time Discharge time

Unloaded voltage Terminal voltage under no-load conditions about 2 seconds before
start

Starting voltage Terminal voltage about 500 ms after start

Starting low voltage Low voltage at terminals about 500 ms after start

Starting high voltage High voltage at terminals about 500 ms after start

Finished voltage Terminal voltage at completion of discharge

Finished low voltage Low voltage at terminals at completion of discharge

Finished high voltage High voltage at terminals at completion of discharge

NOTE

• Low and High voltages are not recorded for any discharge other
than pulse discharge.
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6.5 Pasting Data into Spreadsheet
Applications

You can paste charge and discharge data displayed in the Test Result properties to
spreadsheet application via the clipboard. Press the [Select All] button in the Test
Result properties to select the entire area, then press the [Copy] button to copy the
data to the clipboard.

Then select [Paste] from your spreadsheet’s [Edit] menu.

6.6 Print
CD Data Graph can print graphs as well as the items displayed in the Test Result
properties.

You may print a selected graph (normal printing) or continuously print all graphs
displayed in the CD Data Graph screen.

To perform normal printing, select [Print] from the [File] menu.

To perform continuous printing, select [Print Continuous] from the [File] menu.
Selecting continuous printing displays the following dialog box.

Fig. 52 Selecting Graphs for Continuous Printing

CD Data Graph prints charge-discharge data graphs continuously in all windows
according to the graph type checked in this dialog box.

6.6.1 Color Print
CD Data Graph switches between black and white and color printing. To print in
color, check [Color Print] in the [File] menu.

When you print in color, voltage and current lines are printed in green and red,
respectively, to match the screen display.
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6.7 Saving Data in Text Format
All data (in the General Info, Charge, and Discharge pages) observable in the Test
Result properties may be saved in text format. Files saved in text format may be
opened by word processor or spreadsheet applications.

To save data as text, select [Save As Text] from the [File] menu.

The default file name is a charge-discharge data file name with the “.txt” file
extension.
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6.8 CD Data Graph Menus

Function

File Open Opens a charge-discharge data file (files having the extension *.dcd).

Find File Finds a charge-discharge data file.

Open Previous
Cycle

Opens the file for a cycle preceding the currently loaded file, if one exists.
When the 11A0005Tcedt.dcd file is loaded, for example, this command opens
the 11A0004Tcedt.dcd.

Open Next Cycle Opens the file for a cycle next to the currently loaded file, if one exists.
When the 11A0006Tcedt.dcd file is loaded, for example, this command opens
the 11A0007Tcedt.dcd.

Close Closes the charge-discharge data file.

Save As Text Saves charge-discharge data in text format.  The text file extension is (*.txt).
The command also allows you to specify a name for the charge-discharge
data file.

Print Prints a charge-discharge data graph.

Print Continuous Prints the charge-discharge data graphs in all windows continuously,
allowing selection between the data (charge or discharge) to be printed.

Print Preview Provides an on-screen preview of print output.

- About print preview:
Some printer drivers may not correctly reflect the character width of some
font types (such as TrueType font).  Lines in the print preview screen may
flow past the right-hand margin.  The actual printout will have correct
character widths.

Printer Setup Allows you to select a printer and set the printing method.  The items to be
set depend on the selected printer.

Color Print Switches between black and white and color printing.  Prints in color when
checked.

Exit Exits CD Data Graph.

Edit Copy Allows you to copy and save charge-discharge data to the clipboard.

View Charge Graph Displays voltage and current graphs for charge data (charge + rest).

Discharge Graph Displays voltage and current graphs for discharge data (discharge + rest).

Charge setting
Values

On charge graphs, this command displays the set maximum voltage for CC
charge, or the set CV voltage for CC-CV charge.

Toolbar Displays or hides the toolbar.

Statusbar Displays or hides the state bar.

Graph Scale Allows you to set scale, grids, and pens for graphs.

Test Results Properties Displays test results.

Window Cascade Displays overlapping windows, with title bars visible.  This display mode
allows quick selection of a particular window.

Tile Horizontally Displays all windows, tiled horizontally and without overlap.

Tile Vertically Displays all windows, tiled vertically and without overlap.

Arrange Icons Arranges icons at an equal intervals both horizontally and vertically.

Close All Closes all windows.

Menu
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Chapter 7

Life Data Graph
This chapter describes how to graph the life data (extension: *.lif) created by the Test
Executive, either for on-screen display or for printouts.

7.1 Opening a Life File
To display graphs, you may either directly specify the appropriate folder and file
names, or find the file by using certain conditions.

7.1.1 Graphing by specifying a file name
To display graphs by specifying a file name directly, select [Open] from the [File]
menu.

In the dialog box, specify the name of the folder containing the charge-discharge data
files created by the Test Executive and select a desired life file.

Graphs for the specified file are displayed.

Fig. 53 Opening a Life File

Graphing the Life Results
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7.1.2 Graphing by retrieving a file
To display graphs by finding a charge-discharge data file using file retrieval
conditions, select [Find File] from the [File] menu. The following Find File dialog
box appears.

Fig. 54 Finding a Life File 1/2

Click the [Browse...] button at “Find for” to specify the folder name of the charge-
discharge data files created by the Test Executive.

Fig. 55 Specifying the Folder

Specify the folder and click the [OK] button. This returns you to the preceding dialog
box.
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After specifying the folder, set the retrieval conditions. There are two retrieval
conditions: one for “Find All Files” and another for “Specify File To Find.”

When you select “Specify File To Find,” the Find File dialog box allows you to
specify a frame, unit, and channel. The Life Data Graph executes retrieval by OR of
the condition specified here.

After specifying the retrieval conditions, click the [Next] button. The following
dialog box appears, listing all the files that satisfy the retrieval conditions.

Fig. 56 Finding a Life File 2/2

From the list, select a life data file you wish to graph and click the [Finish] button.
Graphs for the selected file are displayed.

NOTE

• The maximum number of files that may be retrieved is 2000.



90 Graphing the Life Results SD03-PFX

7.2 Displaying Graphs
Graphs display capacity data for charge and discharge together.

You can select [Capacity Rate 100%]/[Capacity True Value] from the [View] menu
to switch the vertical axis (Y axis) between “%” and “Ah” display.

You can also select [Linear]/[Logarithmic] from the [View] menu to switch the
horizontal axis (X axis) between “linear” and “logarithmic” display.

Graph types are identified by color, as shown below:

Charge capacity graph ➝ red

Discharge capacity graph ➝ green

Fig. 57 Graph Display
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7.3 Setting Graph Axes
You can select [Graph Scale] from the [View] menu to change the formats of the
vertical (Y) and horizontal (X) axes of graphs.

Fig. 58 Screen for Changing Graph Axes

The Graph Scale properties sheet consists of the “X axis”, “Y axis”, and “Style”
pages.

7.3.1 Setting items in the [X axis] and [Y axis]
properties

Set the following items.

[Step] slider

Adjust the slide knob to set the number of divisions of the axis, from 1 to 12.

[Min], [Max] and [Step] boxes

In the X-axis property page, enter the minimum and maximum values for graphs in
linear display and logarithmic display.

In the Y-axis property page, enter the minimum and maximum values for the graphs
in capacity rate display and measured capacity values.

The present value per division is displyed at the [Step] box.
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7.3.2 Setting items in the [Style] property
Set the following items.

[Grid] check box

Check this check box to superimpose grids upon graphs.

[Step] slider

Adjust the slider knob to set the size of the grid squares to one of 2, 4, or 5.

[Pen Width]

Sets the width of the pen of the data.

[Back Color, Axis Color, Axis Width]

Sets the Back Color, Axis Color and Axis Width of Graph.
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7.4 Displaying the Test Results
You can browse the capacity data for the test conditions and test results of the graphs
displayed. To display test results, select [Properties] from the [Test Results] menu.

The Test Result properties sheet consists of the following four pages.

1. The “General Info” property page, which displays nominal values for the battery
being tested, conditions for life judgement, and other information

2. A “Sequence” property page displaying the sequence in which a charge-
discharge test was conducted and the test conditions applied

3. A “Test Results” property page displaying cycle-basis capacity data for charge-
discharge and test results

4. “Others” property page used to set the reference cycle for capacity rate (cycle
regarded as 100%) displayed in the “Test Results” property page

7.4.1 [General Info] property
This property lists nominal values for the battery being tested and the conditions for
life judgement, and others.

Fig. 59 Test Results of General Info

[Memo] box

Allows you to enter up to single-byte 30 characters of comments for the test results.
When printed, a character string entered here is displayed in the memo item.
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7.4.2 [Sequence] property
This property displays the sequence in which the charge-discharge test was
conducted and the test conditions applied.

Fig. 60 Test Results of Sequence
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7.4.3 [Test Results] property
This property displays the cycle-basis capacity data for charge-discharge and the test
results.

Fig. 61 Test Results of Test Results
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■ Test Results

This section displays the results of charge-discharge testing. 

Test result item Description

First Charge Capacity(mAh) Charge capacity of the first cycle

Max Charge Capacity(mAh) Maximum charge capacity value in the test

Max Charge Cycle(P/R/L) The number of cycles for the maximum charge capacity
and the number of patterns/repeats/loops in the test

Min Charge Capacity(mAh) Minimum charge capacity value in the test

Min Charge Cycle(P/R/L) The number of cycles for the minimum charge capacity
and the number of patterns/repeats/loops in the test

First Discharge Capacity(mAh) Discharge capacity of the first cycle

Max Discharge Capacity(mAh) Maximum discharge capacity value in the test

Max Discharge Cycle(P/R/L) The number of cycles for the maximum discharge
capacity and the number of patterns/repeats/loops in the
test

Min Discharge Capacity(mAh) Minimum discharge capacity value in the test

Min Discharge Cycle(P/R/L) The number of cycles for the minimum discharge
capacity and the number of patterns/repeats/loops in the
test

Cycle Total number of cycles since the start of a test sequence
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7.4.4 [Others] property
This property allows you to set the reference cycle for the capacity rate (cycle
regarded as 100%) that is displayed in the “Test Results” property page.

Fig. 62 Test Results of Others
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7.5 Pasting Data into Spreadsheet
Applications

You can paste the numeric data displayed in the “Test Results” page of the “Test
Result” properties into spreadsheet application via the clipboard. Press the [Select
All] button in the “Test Result” properties to select the entire area, then press the
[Copy] button to copy the data to the clipboard.

Then select [Paste] from the [Edit] menu of spreadsheet application.

7.6 Printing
The Life Data Graph allows you to print the graphs displayed, as well as items
displayed in Test Result properties.

You may print a selected graph (normal printing) or continuously print all graphs
displayed in the Life Data Graph screen (continuous printing).

To perform normal printing, select [Print] from the [File] menu.

To perform continuos printing, select [Print Continuous] from the [File] menu.
Selecting continuous printing displays the following dialog box.

Fig. 63 Selecting Graphs for Print Continuous

The Life Data Graph prints graphs continuously in all windows according to the
graph type checked in this dialog box.

7.6.1 Color Printing
The Life Data Graph switches between black and white and color printing. To print
in color, check [Color Print] in the [File] menu.

When you print in color, charge capacity and discharge capacity are printed in red
and green, respectively, to match the screen display.
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7.7 Saving Data in Text Format
All data (in the General Info, Test Sequence, and Test Results pages) observable in
the “Test Result” properties may be saved in text format. Files saved in text format
may be opened by word processor or spreadsheet applications.

To save data as text, select [Save As Text] from the [File] menu.

The default file name is a life data file name with the “.txt” file extension.
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7.8 Life Data Graph Menus

Function

File Open Opens a life data file (files having the extension *.lif).

Find File Finds life data files.

Close Closes a life data file.

Save As Text Saves life data in text format.  The text file extension is (*.txt).  The
command also allows you to specify a name for the life data file.

Print Prints life data graph.

Print Continuous Prints life data graphs in all windows continuously, with options for
selecting the data to be printed (X axis: linear or logarithmic; Y axis:
capacity rate 100% or measured capacity values).

Print Preview Provides an on-screen preview of print output.

- About print preview:
Some printer drivers may not correctly reflect the character width of some
font types (such as TrueType font).  Lines in the print preview screen may
flow past the right-hand margin.  The actual printout will have correct
character widths.

Print Setup Allows you to select a printer and set the printing method.  Items to be set
up depend on the selected printer.

Color Print Switches between black and white and color printing.  Prints in color when
checked.

Exit Exits the Life Data Graph.

Edit Copy Allows you to copy test data to the clipboard in text format.

View Linear Displays the cycle axis of life data graphs in linear form.

Logarithmic Displays the cycle axis of life data graphs in logarithmic form.

Capacity Rate
100%

Displays the capacity axis of life data graphs, with the charge-discharge
capacity of the reference cycle set as 100%.  You can set the reference cycle
on the [Others] sheet by selecting [Properties] from the [Test Results] menu.

Capacity True
Value

Displays the capacity axis of life data graph in measured capacity values.

Toolbar Displays or hides the toolbar.

Status Bar Displays or hides the state bar.

Graph Scale Allows you to set the scales, grids, and pens of graphs.

Test Results Properties Displays the test results.

Window Cascade Displays overlapping windows, with title bars visible.  This display mode
allows quick selection of a particular window.

Tile Horizontally Displays all windows, tiled horizontally and without overlap.

Tile Vertically Displays all windows, tiled vertically and without overlap.

Arrange Icons Arranges icons at an equal intervals both horizontally and vertically.

Close All Closes all windows.

Menu
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8.1 Hard Disk Space Required
The size of a cycle-basis charge-discharge data file (extension: .dcd) created by the
Test Executive varies with test time or the particular recording method for test
conditions (such as delta voltage and delta current), changing according to the
following equation.

File size = 548 bytes (header) + (24 bytes x number of charge data points) +
(24 bytes x number of discharge data points)

Because the maximum number of points is 1024 for both charge and discharge, the
file size reached when all 1024 points are saved is about 48.6 KB.

When a data file of this maximum number of points is saved for each cycle, the
following disk space is required per channel.

Considerable disk space is required, depending on the number of channels and
cycles. Thus, ways to eliminate unnecessary data efficiently should be considered.

Capacity data files (extension: .lif) use the following space per channel.

File size = 2122 bytes (header) + (8 bytes x number of cycles)

The Windows cluster allocation system reserves an entire separate cluster for all files
up to the size of a single cluster. Particular cluster sizes are given in the table below.

You must consider in advance the number of files to be created, based on the type of
the hard disk format in use and hard disk space.
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8.2 Printer Output of Test Conditions 1/2

Test Condition Editor
Battery Performance Checker 12 SD03-PFX(E)

KIKUSUI SD03-PFX(E) Version 1.30

C:\Program Files\Kikusui\Sample\Sample.tst

Date Monday, July 19, 1999
Operator Kikusui Electronics Corp.
Battery type Li-ion
Note Sample
----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------
Channel Structure 12Channels/Frame
Battery Nominal Value Capacity(mAh) 800.0

Voltage(V) 3.700
Fixed-Time Operation Off
DUT Protection V/Cap Protect. On

OVP(V) 4.300
UVP(V) 2.500
OAH(%) 150
Confirm Combine On

Recording Method T/1024
Delta Voltage(mV) 20,On
Delta Current(mA) 20,On
Delta Time(s) 3600,On

Life Judgement Judgement Off
Capacity Rate(%) 0
Count 1

Test Sequence Pattern:Repeat,Record
 1:  1, On  2:  1, On  3:  1, On  4:  0,Off  5:  0,Off
 6:  0,Off  7:  0,Off  8:  0,Off  9:  0,Off 10:  0,Off
11:  0,Off 12:  0,Off 13:  0,Off 14:  0,Off 15:  0,Off
Loop(s) 10

----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------
*Predischarge
   Mode CC
   Disch. Time(h:min) 3:00
   Rest Time(h:min) 0:10
   Current(A) 0.400
   Wattage(W) 0.00
   Limit Current(A) 0.000
   Pulse Current1(A) 0.010
   Pulse Time1(ms) 0.50
   Pulse Current2(A) 0.010
   Pulse Time2(ms) 0.50
   Pulse Current3(A) 0.010
   Pulse Time3(ms) 0.50
   Pulse Current4(A) 0.010
   Pulse Time4(ms) 0.50
   Capacity Voltage(V) 2.900
   Cutoff Voltage(V) 2.900
----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------
*Charge Pattern1 Pattern2 Pattern3 Pattern4 Pattern5
   Mode CC-CV CC-CV CC-CV CC-CV CC-CV
   Current(A) 0.400 0.400 0.600 0.000 0.000
   Charge Time(h:min) 3:00 3:00 3:00 0:00 0:00
   Rest Time(h:min) 0:10 0:10 0:10 0:01 0:01
   CV Voltage(V) 4.200 4.200 4.100 0.000 0.000
   CV Time(h:min) 2:00 2:00 2:00 0:00 0:00
   It Current(A) 0.040 0.040 0.100 0.000 0.000
   It Time(h:min) 0:10 0:10 0:00 0:00 0:00
   Max Voltage(V) 0.000 0.000 0.000 0.000 0.000
   -dV(V) 0.001 0.001 0.001 0.001 0.001
   -dV Mask Time(min) 1 1 1 1 1
----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------
*Discharge Pattern1 Pattern2 Pattern3 Pattern4 Pattern5
   Mode CC CP Pulse2 CC CC
   Disch. Time(h:min) 2:00 2:00 2:00 0:00 0:00
   Rest Time(h:min) 0:10 0:10 0:10 0:01 0:01
   Current(A) 0.800 0.800 0.800 0.000 0.000
   Wattage(W) 0.00 2.50 0.00 0.00 0.00
   Limit Current(A) 0.000 0.800 0.000 0.000 0.000
   Pulse Current1(A) 0.010 0.010 2.000 0.010 0.010
   Pulse Time1(ms) 0.50 0.50 0.58 0.50 0.50
   Pulse Current2(A) 0.010 2.000 0.010 0.010 0.010
   Pulse Time2(ms) 0.50 0.50 4.70 0.50 0.50
   Pulse Current3(A) 0.010 0.010 0.010 0.010 0.010
   Pulse Time3(ms) 0.50 0.50 0.50 0.50 0.50
   Pulse Current4(A) 0.010 0.010 0.010 0.010 0.010
   Pulse Time4(ms) 0.50 0.50 0.50 0.50 0.50
   Capacity Voltage(V) 2.900 2.900 2.850 0.000 0.000
   Cutoff Voltage(V) 2.900 2.900 2.850 0.000 0.000
----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

1/2
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8.3 Printer Output of Test Conditions 2/2

Test Condition Editor
Battery Performance Checker 12 SD03-PFX(E)

KIKUSUI SD03-PFX(E) Version 1.30

C:\Program Files\Kikusui\Sample\Sample.tst

*Charge Pattern6 Pattern7 Pattern8 Pattern9 Pattern10
   Mode CC-CV CC-CV CC-CV CC-CV CC-CV
   Current(A) 0.000 0.000 0.000 0.000 0.000
   Charge Time(h:min) 0:00 0:00 0:00 0:00 0:00
   Rest Time(h:min) 0:01 0:01 0:01 0:01 0:01
   CV Voltage(V) 0.000 0.000 0.000 0.000 0.000
   CV Time(h:min) 0:00 0:00 0:00 0:00 0:00
   It Current(A) 0.000 0.000 0.000 0.000 0.000
   It Time(h:min) 0:00 0:00 0:00 0:00 0:00
   Max Voltage(V) 0.000 0.000 0.000 0.000 0.000
   -dV(V) 0.001 0.001 0.001 0.001 0.001
   -dV Mask Time(min) 1 1 1 1 1
----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------
*Discharge Pattern6 Pattern7 Pattern8 Pattern9 Pattern10
   Mode CC CC CC CC CC
   Disch. Time(h:min) 0:00 0:00 0:00 0:00 0:00
   Rest Time(h:min) 0:01 0:01 0:01 0:01 0:01
   Current(A) 0.000 0.000 0.000 0.000 0.000
   Wattage(W) 0.00 0.00 0.00 0.00 0.00
   Limit Current(A) 0.000 0.000 0.000 0.000 0.000
   Pulse Current1(A) 0.010 0.010 0.010 0.010 0.010
   Pulse Time1(ms) 0.50 0.50 0.50 0.50 0.50
   Pulse Current2(A) 0.010 0.010 0.010 0.010 0.010
   Pulse Time2(ms) 0.50 0.50 0.50 0.50 0.50
   Pulse Current3(A) 0.010 0.010 0.010 0.010 0.010
   Pulse Time3(ms) 0.50 0.50 0.50 0.50 0.50
   Pulse Current4(A) 0.010 0.010 0.010 0.010 0.010
   Pulse Time4(ms) 0.50 0.50 0.50 0.50 0.50
   Capacity Voltage(V) 0.000 0.000 0.000 0.000 0.000
   Cutoff Voltage(V) 0.000 0.000 0.000 0.000 0.000
----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------
*Charge Pattern11 Pattern12 Pattern13 Pattern14 Pattern15
   Mode CC-CV CC-CV CC-CV CC-CV CC-CV
   Current(A) 0.000 0.000 0.000 0.000 0.000
   Charge Time(h:min) 0:00 0:00 0:00 0:00 0:00
   Rest Time(h:min) 0:01 0:01 0:01 0:01 0:01
   CV Voltage(V) 0.000 0.000 0.000 0.000 0.000
   CV Time(h:min) 0:00 0:00 0:00 0:00 0:00
   It Current(A) 0.000 0.000 0.000 0.000 0.000
   It Time(h:min) 0:00 0:00 0:00 0:00 0:00
   Max Voltage(V) 0.000 0.000 0.000 0.000 0.000
   -dV(V) 0.001 0.001 0.001 0.001 0.001
   -dV Mask Time(min) 1 1 1 1 1
----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------
*Discharge Pattern11 Pattern12 Pattern13 Pattern14 Pattern15
   Mode CC CC CC CC CC
   Disch. Time(h:min) 0:00 0:00 0:00 0:00 0:00
   Rest Time(h:min) 0:01 0:01 0:01 0:01 0:01
   Current(A) 0.000 0.000 0.000 0.000 0.000
   Wattage(W) 0.00 0.00 0.00 0.00 0.00
   Limit Current(A) 0.000 0.000 0.000 0.000 0.000
   Pulse Current1(A) 0.010 0.010 0.010 0.010 0.010
   Pulse Time1(ms) 0.50 0.50 0.50 0.50 0.50
   Pulse Current2(A) 0.010 0.010 0.010 0.010 0.010
   Pulse Time2(ms) 0.50 0.50 0.50 0.50 0.50
   Pulse Current3(A) 0.010 0.010 0.010 0.010 0.010
   Pulse Time3(ms) 0.50 0.50 0.50 0.50 0.50
   Pulse Current4(A) 0.010 0.010 0.010 0.010 0.010
   Pulse Time4(ms) 0.50 0.50 0.50 0.50 0.50
   Capacity Voltage(V) 0.000 0.000 0.000 0.000 0.000
   Cutoff Voltage(V) 0.000 0.000 0.000 0.000 0.000
----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

2/2
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8.4 Printer Output of Charge Graphs

CD Data Graph
Battery Performance Checker 12 SD03-PFX(E)

KIKUSUI SD03-PFX(E) Version 1.30

C:\Program Files\Kikusui\Sample\11A0001sample.dcd

DUT Name
Frame:Unit 1:1A
Operator Kikusui Electronics Corp.
Battery Type Li-ion
Note Sample

Cycle(P/R/L) 1(1/1/1)
Starting Date-Tim e 20/07/ 99 3:10:49
Stopping Date-Time 20/07/ 99 7:48:11

Memo

Nominal Capacity(mAh)800.0
Nominal Voltage(V) 3.700
V/Cap Protect. On
OVP(V) 4.300
UVP(V) 2.500
OAH(%) 150
Recording method T/1024
Delta Voltage(mV) 20,On
Delta Current(mA) 20,On
Delta Time(s) 3600,On
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*Charge Condition
   Mode CC-CV
   Current(A) 0.400
   Charge Time(h:min) 3:00
   Rest Time(h:min) 0:10
   CV Voltage(V) 4.200
   CV Time(h:min) 2:00
   It Current(A) 0.040
   It Time(h:min) 0:10

*Charge Result
   Finished By Charge Time
   Charge Capacity(mAh) 831.7
   Charge Time(h:min:s) 3:00:00
   CC Time(h:min:s) 1:20:22
   Unloaded Voltage(V) 3.490
   Starting Voltage(V) 3.821
   Max Voltage(V) 4.200
   Finished Voltage(V) 4.200
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8.5 Printer Output of Discharge Graphs

CD Data Graph
Battery Performance Checker 12 SD03-PFX(E)

KIKUSUI SD03-PFX(E) Version 1.30

C:\Program Files\Kikusui\Sample\11A0001sample.dcd

DUT Name
Frame:Unit 1:1A
Operator Kikusui Electronics Corp.
Battery Type Li-ion
Note Sample

Cycle(P/R/L) 1(1/1/1)
Starting Date-Tim e 20/07/ 99 3:10:49
Stopping Date-Time 20/07/ 99 7:48:11

Memo

Nominal Capacity(mAh)800.0
Nominal Voltage(V) 3.700
V/Cap Protect. On
OVP(V) 4.300
UVP(V) 2.500
OAH(%) 150
Recording method T/1024
Delta Voltage(mV) 20,On
Delta Current(mA) 20,On
Delta Time(s) 3600,On
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*Discharge Condition
   Mode CC
   Discharge Time(h:min) 2:00
   Rest Time(h:min) 0:10
   Current(A) 0.800
   Capacity Voltage(V) 2.900
   Cutoff Voltage(V) 2.900

*Discharge Result
   Finished By Cutoff Voltage
   Discharge Capacity(mAh) 646.6
   Discharge Time(h:min:s) 0:48:32
   Unloaded Voltage(V) 4.171
   Starting Voltage(V) 3.909
   Finished Voltage(V) 2.900
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8.6 Printer Output of Life Graphs

Life Data Graph
Battery Performance Checker 12 SD03-PFX(E)

KIKUSUI SD03-PFX(E) Version 1.30

C:\Program Files\Kikusui\Sample\11Asample.lif

DUT Name
Frame:Unit 1:1A
Operator Kikusui Electronics Corp.
Battery Type Li-ion
Note Sample

Cycle(P/R/L) 11(2/1/4)
Starting Date-Tim e 20/07/ 99 3:10:49
Stopping Dtae-Time 21/07/ 99 23:37:45

Memo

Nominal Capacity(mAh) 800.0
Nominal Voltage(V) 3.700
Life Judgement Off
Life Capacity Rate(%) 0
Life Count 1
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Cycle
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(%) Charge-Discharge Capacity Rate Discharge

Charge

*Charge-Discharge Result
   First Charge Capacity(mAh) 831.7
   Max Charge Capacity(mAh) 831.7
   Max Charge Cycle(P/R/L) 1(1/1/1)
   Min Charge Capacity(mAh) 500.0
   Min Charge Cycle(P/R/L) 6(3/1/2)
   First Discharge Capacity(mAh) 646.6
   Max Discharge Capacity(mAh) 663.5
   Max Discharge Cycle(P/R/L) 8(2/1/3)
   Min Discharge Capacity(mAh) 455.7
   Min Discharge Cycle(P/R/L) 3(3/1/1)
   Cycle 11
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Index

1

12 channels 28

6

6 channels 28

A

AC Line 53

B

Battery Nominal Values 29

C

Capacity Rate 31

Capacity Voltage 38, 39

CC 35, 36, 52

CD Data Graph 6, 9, 73

CD/B 52

Channel Configuration 16, 28

[Charge] property 80

Charge Time 18, 35

Charge-discharge data files 68

Color Printing 84, 98

Communication Error 53

Communications requirements 8

Condition Record 31

Conditions of termination under which a test

may be resumed 57

Connection Check 30

Connection Error 52

Constant current charge 19

Constant current discharge 20

Constant current — constant voltage charge 18

Constant power discharge 21

CP 52

Creating the Test Conditions 26

Cutoff voltage 20, 21, 39

CV Time 18, 35

CV Voltage 35

D

Data-recording intervals 31

Delta Current 31, 32

Delta Time 31, 32

Delta Voltage 31, 32

Detailed Alarm Information and Appropriate

Correct 72

DIP switches 12

[Discharge] property 82

Discharge Time 20, 21, 37

Displaying Graphs 90

Displaying the Test Results 79, 93

DUT Names 53

DUT Protection 29

-dV 19, 36

-dV mask time 36

E

Emergency Stop 71

-END- 53

F

File close 70

File names assigned 68

First Charge Capacity 96

First Discharge Capacity 96

Fixed-Time Operation 30

Flow of test procedure 9

Frame Configuration 15

Frame Connection 46, 70

G

[General Info] property 79, 93

GPIB Address Primary 8

GPIB board 8

GPIB cable 8, 14

GPIB driver 8

Graph Scale properties sheet 54

Graphing the Life Results 87
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I

“idle” with respect 14

Install 11

Interface Name 8

It Current 18, 35

It Time 18, 35

L

Life 53

Life data files 68

Life Data Graph 6, 9, 69, 87

Life Judgement 31, 53

Limit Current 21, 38

M

Max Charge Capacity 96

Max Charge Cycle 96

Max Discharge Capacity 96

Max Discharge Cycle 96

Maximum Voltage 19, 31, 36

Min Charge Capacity 96

Min Charge Cycle 96

Min Discharge Capacity 96

Min Discharge Cycle 96

Monitor Data Update Interval 54

N

Normal printing 84

O

OAH 14, 29, 52, 53

OHP 52

Operational state 52
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